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2 About this document 
 

Use 
> Please read this documentation through carefully and 

familiarize yourself with the product before putting it to use. Pay 
particular attention to the safety instructions and warning advice 
in order to prevent injuries and damage to the products. 

> Keep this document to hand so that you can refer to it when 
necessary.  

> Hand this documentation on to any subsequent users of the 
product. 

 

 
Knowledge of Windows® operating systems is required 
when working with the software. 

 
 

Symbols and writing standards 
 

Representa-
tion  

Explanation  

 
Note: Basic or further information. 

1. ... 
2. ... 

Action: more steps, the sequence must be 
followed. 

> ... Action: a step or an optional step. 

- ... Result of an action. 

Menu Elements of the program interface. 

[OK] Buttons of the program interface.  

... | ... Functions/paths within a menu. 

“...” Example entries 
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3 Specifications 
 

3.1. Use 
 

The IRSoft software is used for the analysis, processing and 
archiving of the images recorded by a testo thermal imager. It also 
has integrated reporting for the clear presentation of the data. 
The settings can be performed on the connected thermal imager 
via the instrument control. 

 

3.2. System requirements 
 

Operating system 
The software can be run on the following operating systems: 
• Windows® 7 Service Pack 1(32 bit / 64 bit) 
• Windows® 8 (32 bit / 64 bit) 
• Windows® 10 (32 bit / 64 bit) 
 

 

Computer 
The computer must meet the requirements of the corresponding 
operating system. The following requirements must additionally be 
fulfilled:: 
• Interface USB 2.0 or higher 
• Internet Explorer 6.0 or higher 
• When used in conjunction with testo 882, testo 885 and 

testo 890: 
◦ Intel Core i3-2310M 2.1 GHz, Intel Pentium Dual Core 

E2220 2.4 GHz 2.4 GHz or AMD Athlon 64 X2 4400+ 
◦ 4 GB RAM 
◦ 3 GB available hard drive capacity 
◦ DirectX 9c graphics device 
◦ For computers with Windows 7 operating system:  

WDDM 1.0 driver 
Information/special requirements for the video function: 
• Windows 7 ServicePack 1 (32 bit/64 bit) 
• No remote desktop support 
• No terminal server 
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• Hardware device (HAL) required. This is missing in some virtual 
environments, we recommend VMWare Workstation 
>Version 6. 

• Only WDDM drivers are supported. The use of XDDM drivers 
may work but is not recommended, as it leads to performance 
losses. 

• Due to the large amounts of data, we recommend using an 
internal hard drive or a serial ATA BUS to capture videos. 

• Processes running in parallel may have a considerable impact 
on the speed when showing and capturing videos. We 
recommend closing any programs that are not required. 

• The maximum video stream frequency is 25 Hz. Depending on 
the system environment, the achievable value may be lower. To 
achieve the highest possible video stream frequency, we 
recommend: 
◦ Using Windows 7 SP1 64 bit. 
◦ Using a dedicated graphics card with a separate local 

memory. 
◦ Capturing without analysis tools, which can be added during 

later evaluation. 
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4 First steps 
 

4.1. Installing the software/driver 
 

 
Administrator rights are required for installation. 

 
 

1. Insert the program CD in the CD-ROM drive of the computer. 
If the installation program does not start automatically: 
> Open My Computer, select the CD drive and start the 

Setup.exe file. 
2. Follow the instructions of the installation wizard. 
3. To finish the software installation, click on [Finish]. 
After completion of the software installation, the instrument must be 
connected to the PC to continue with the driver installation. 

4. Switch on the instrument: [ ]. 
5. Connect the instrument to the PC using the USB cable. 
- The connection is established. 
- The driver installation is performed automatically. 
In some cases, the instrument driver may not be automatically 
recognized. In this case, continue as follows:  
- The Found New Hardware window is opened. 
1. Click on Locate and install driver software and then on 

[Continue]. 
If the driver is not automatically found: 
> Click on Browse my computer for driver software and then 

click on [Browse]. Enter the driver path in the CD directory: 
Driver folder:  

- The Windows Security window opens:  
2. Click on Install this driver software anyway. 
3. Click on [Close]. 
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4.2. Starting the software 
 

Start IRSoft 
 

 
The user interface of the software is opened in the 
language of the operating system if this is supported. If 
the operating system language is not supported, the 
user interface is in English. 

 

> Click on  | (All) Programs | Testo | IRSoft. 
 
 

Establishing a connection with the instrument 

1. Press the [ ] button to switch on the instrument. 
2. Connect the instrument to the PC using the USB cable. 
- The connection is established.  
- The instrument switches into slave mode, where all control keys 

of the instrument are deactivated except the [ ] button. 
- The instrument is identified by the PC as a USB memory 

device. The operating system automatically assigns the 
memory of the instrument (SD card) a drive letter. This is 
displayed in Windows Explorer. 

 

Using the Import Wizard 
The Import Wizard supports you when transferring images from the 
thermal imager to the PC. 

 

 
Only .bmt and .bmp files and folder structures are 
transferred. 

1. Click on [Continue]. 
2. Highlight the folders or images to be transferred. 
When a folder is marked, all subfolders are automatically included.  
3. Click on [Continue]. 
4. Select the location you want to save them to: 

• In the archive (only for images from imagers that support 
site recognition, e.g. testo 885 / 890) 

• In the file system (target directory must be specified). 
> If required, activate the optional functions Set target directory 

as default and Delete data in the device after copying. 
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5. Click on [Continue]. 
- When importing to the file system: In the selected target 

directory, a folder is created with the date of the data transfer to 
prevent the overwriting of previous folders with the same 
designation. The folders and the images are saved in this 
directory. 

- When adding to the archive: the images are inserted into the 
archive structure. Existing images are not overwritten. 

6. Click on [Finish]. 
- The Import Wizard is closed. 

Activating/deactivating the Import Wizard 
> In IRSoft click on the Imager tab and carry out the desired 

change in the Import Wizard group. 
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5 Product description 
 

5.1. User interface 

 
1 Ribbon 
2 Work space 
3 Status bar 
Explanations of the individual areas: see below. 

5.2. Ribbon 

 
The ribbon helps you to carry out modifications and settings and to 
find the relevant functions and commands quickly.  
The functions are divided into different groups on four tabs: 
Analysis, Report, Imager and Settings. 
The functions/commands vary depending on the tab selected. 
The tab Analysis contains function/commands for: 
• Opening and saving infrared images 
• Setting and copying image properties 
• Playing/saving audio comments 
• Creating image overlays (IR image - real image) 
• Copying image settings 

 
If no IR image is opened, only the function for opening IR 
images is displayed. 
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The tab Report contains function/commands for: 
• Creating reports 
• Editing reports 
The tab Imager contains function/commands for: 
• Configuring the thermal imager 
• Activating/deactivating the Import Wizard 
The Video tab includes functions/commands for: 
• Capturing and analysing videos 
The Archive tab includes functions/commands for: 
• Archiving images (for cameras with the site recognition function) 
The tab Settings contains function/commands for: 
• Setting the work space view 
• Setting the infrared image presentation 
• Setting the temperature unit 
• Setting the user interface view (colour scheme) 
• Activating/deactivating the tips 
• Activating/deactivating the automatic program updates 
• Setting the image preview (IR image/real image) 
• Creating user-generated report templates 

5.3. Work space 
 

 
Information is shown and editing performed in the work space. The 
work space display varies depending on the page layout selected. 
The work space is divided into different document windows: 
1 Thermal image (see Thermal image document window, page 

25) 
2 Temperature scale (see Temperature scale document window, 

page 30) 
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3 Histogram (see Histogram document window, page 33) 
4 Thermal image markings (see Thermal image markers 

document window, page 34) 
5 Real image (see Real image document window, page 36) 
6 Profile (see Profile document window, page 38) 
7 Comments (see Comments document window, page 39) 

 

 
Depending on the work space view selected and the size of 
the screen, not all document windows are visible. If 
necessary, use the scroll bars. 

 
 

 

The work spaces on the Video and Archive tabs are set 
up differently. Refer to the description in the relevant 
sections. 

 

5.4. Status bar 
 

 
 
Information on the open image is shown in the status bar: Audio 

comments exist  (possible to play by clicking on the symbol)/do 

not exist , imager type, number of pixels, image type (only in the 
case of SuperResolution and panoramic images), recording date, 
min./max./mean value. 

It is possible to change the work space view via  (tabs) and  
(overlapping windows). 
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6 Using the software 
 

6.1. Performing program settings 
Program settings can be performed on the Settings tab. 

 

6.1.1. Modifying the work space view 

Tabbed windows/overlapping windows 
The work space view can be modified in the Settings tab. 
1. In the ribbon, click on the Settings tab. 
2. Modify the work space view in the Work space view group. 

> For quick changes to the work space view: Click on  (tabs) 

or  (overlapping windows) in the status bar. 

Tab groups 
Arranging the tabs into groups makes it easier to compare several 
IR images. 
Prerequisites:  
• At least 2 IR images are open. 
• The Tabbed windows work space view is open, see above. 
1.  Right-click on the tab of an infrared image that you wish to 

compare with another infrared image. 
- A context menu is opened. 
2. From the context menu, select the option New Horizontal / 

New Vertical Tab Group. 
- The infrared image can be compared with the other infrared 

image. 
> If you wish to compare more than 2 images: Repeat the 

procedure starting with step 3. 

 
The user-defined settings for the desktop view are saved 
and available once again during a restart. 
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6.1.2. Image presentation 
The image presentation can be optimized: 
• Image smoothing: the image presentation is optimized by 

means of an algorithm. 
• Radial distortion correction (not available for images from 

testo 870, testo 880, testo 885, testo 890): compensates for the 
optical distortion in images made with wide-angle lenses. 

• Display temperature values: temperature values for the set 
measuring tools (e.g. measuring point, average, hot & cold 
spot) are displayed in the thermal image. 

1. Click on the Settings tab. 
2. Activate/deactivate the desired function under the Image 

presentation group. 

6.1.3. Temperature unit 
The display of temperature values can be changed between the 
units °C and °F. 
1. Click on the Settings tab. 
2. Select the desired option in the Temperature unit group. 

6.1.4. Colour scheme  
The colour scheme of the software interface can be set. 
1. Click on the Settings tab. 
2. Select the desired option in the Colour scheme group. 

6.1.5. Tips (tool hints) 
All of the functions and commands available in this software are 
described in more detail in tips (tool hints) in IRSoft. 
> Move the mouse pointer over the functions/command in IRSoft. 
- Tips (tool hints) are displayed. 
Activate/deactivate tips (tool hints): 
1. Click on the Settings tab. 
2. In the group Tips select the option Display/Hide. 

6.1.6. Program update 
The software can automatically search for program updates. An 
Internet connection is required for this.  
If there is an update, you will be informed.  
1. Click on the Settings tab. 
2. Under the Program update group, activate/deactivate the 

Autom. check function. 
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6.1.7.  Preview image 
Instead of the thermal image, the attached real image (if available) 
can be used for the Explorer preview.  
1. Click on the Settings tab. 
2. Enable/disable the Real image preview function under the 

Settings group. 
 
 

 
Following the switch-over, sometimes the Windows Explorer still 
displays the old preview images, since images were saved in the 
background. 

Remove old preview images: 

1. Click on the Windows Start icon. 
2. In the field Search programs/files, type the command "Disk 

Cleanup". 
- The Disk Cleanup program is displayed under Programs. 
3. Click on Disk Cleanup. 
- Search starts. 
- If there are multiple storage media on the PC, the drive containing 

the old preview images must be selected in the Drive dialogue box 
by clicking on it with the mouse.  

4. Press OK. 
- The program scans the disks for files that can be deleted.  
5. In the dialogue box, select the program file Thumbnail views by 

clicking on it with the mouse (place a ✔). 

6. Press OK. 
> Click on Delete files. 
- The old preview images are removed from the drive. 

6.1.8. Program language 
The program interface language can be changed. 
1. Click on the Settings tab. 

2.  Click on  and select the desired language from the drop-down 
list. 

3. Confirm the advisory message with [OK] and restart the 
software. 

6.1.9. Report templates 
User-specific report templates can be created, see Report 
Designer, page 42. 
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6.2. Selecting images 
 

 
During the image selection of IRSoft, the following images 
are shown: 
• Infrared images without attached real image (IR). 
• Infrared images with attached real imageIV). 
Real images alone (VI) are not displayed.  
> Please use Windows Explorer for access to the real 

images. 
 

Opening infrared images 
 

 

The number of images that can be opened in parallel is 
limited depending on their size (pixel count): 
• 160x120: approx. 52 images 
• 320x240: approx. 50 images 
• 640x480: approx. 36 images 
• 1280x960: approx. 20 images 
• 1712x1214: approx. 9 images 

 
 

1. To open infrared images: 

> In the ribbon, click on the testo logo  and select Open  
or 

> Click on the Analysis tab and select Open . 
> If the Windows dialogue with the infrared images does not 

open: navigate to the directory with the infrared images. 
>  If you wish to display preview images: In the Windows dialogue 

Menu View  | select Thumb view. 
2. Highlight one or several infrared images. 

> If you wish to highlight several images: Hold down the Ctrl-
key and click on the images. 

3. Click on [Open]. 
-  The selected infrared image will be displayed in the Thermal 

image document window. 
- If you have opened an infrared image with an attached real 

image: the real image will be displayed in the Real image 
document window. 

- If several images were highlighted: Depending on the work 
space view selected, the rest of the infrared images will be 
displayed in individual tabs or in individual windows. 

 

To open images stored in the Archive, see Archive (only for 
testo 885 / 890), page 53. 
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Alternatively, you can also select an infrared image when 
IRSoft is not open. In this case, multiple infrared images 
cannot be selected. 
1. Open Windows Explorer and navigate to the directory 

where the infrared images are located. 
2. Double-click on the infrared image you wish to open. 
- IRSoft starts automatically and the selected infrared 

image will be displayed in the Thermal image 
document window. 

 

Importing real images 
See Real image document window page 36. 
see Archive (only for testo 885 / 890), page 59 

 

6.3. Edit image properties 
Image properties can be edited in the Analysis tab. 

 

 
• Changes to the image properties will only be accepted 

for the currently selected infrared image in the Thermal 
image document window. To transfer image properties 
to other open infrared images, see Accepting settings 
for multiple images page 24. 

• Changes in the Parameter group can affect the 
measurement result. 

• The functions in the Colours group are for editing the 
visual presentation of the thermal image and have no 
influence on the measurement results. 

 

1.  In the ribbon, click on the Analysis tab. 
2. Edit the infrared image properties with the functions and 

commands in the ribbon. 

- If changes have been made but not yet saved,  appears after 
the file name. 
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6.3.1. Colours 

Selecting a palette 
You can choose between several existing colour palettes for the 
infrared image. 

> Click on  and select a colour palette from the drop-down list. 
When Humidity image is selected, the relative surface moisture is 
calculated for each pixel and the temperature image is converted to 
a humidity image. The ambient temperature and humidity 
parameters are calculated, together with the measured surface 
temperature. 

 
 

 
With an IR image saved as a humidity image in the thermal 
imager, the parameters entered in the imager are saved 
with the image. 

With an IR image saved as a temperature image in the 
thermal imager, the parameters must be entered later on. If 
this is not done, the image appears completely green. 

 
 

The humidity image shows which areas are at risk of mould: 
 

Colour  Surface moisture Assessment 

green 0…64%RH noncritical 

yellow/orange 65…80%RH potentially critical 

red >80%RH critical 
 

Selecting colour temperature measuring points, profiles and 
histograms 
> Click on Colour temperature measuring points, profile and 

histogram  and select a colour. 

Selecting colour for temperature correction 
Changes the marker colour with the temperature correction in the 
Thermal image document window. 

> Click on Colour region markers  and select a colour for 
infrared image area markers. 

Select colour for coldspots/hotspots 

> Click on Colour coldspot  / Colour hotspot  and select 
a colour. 
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6.3.2. Parameter 
The settings from the recording of the thermal image can be 
corrected. 

 
Changes to the settings influence the measurement 
result. The settings should therefore only be changed 
with the utmost caution. 

 

Function Procedure 

Set Emissivity,  
Reflected temperature,  
Intensity,  
Humidity1,  
Ambient temperature1 
Inside temperatureFehler! 

Textmarke nicht definiert. Outside 
temperatureFehler! Textmarke 

nicht definiert. 
 

> Click on the number and 
change it by means of input via 
the keyboard or via . 

You can find more information on 
the individual properties in the 
instruction manual of the thermal 
imager. 

Dewpoint Dewpoint temperature: The value 
is calculated from the humidity and 
the ambient temperature and 
cannot be changed manually. 

 ScaleAssist The scale limits are automatically 
adjusted to the calculated 
ScaleAssist min./max. values. 

Current (A), Voltage (V), 
Power (W) 

> Click on the number and 
change it by inputting via the 
keyboard or via . 

You can find more information on 
the individual properties in the 
instruction manual of the thermal 
imager. 

Discard changes > If you wish to reset the 
changes back to the most 
recently saved parameters: 
Click on Discard changes .

                                                           
1 The humidity, ambient temperature, inside and outside temperature are 
transmitted by the thermal imager and can be changed in IRSoft. 
When shown as a humidity image: correct values must be entered to calculate 
the relative surface moisture. When shown as a temperature image: the values 
are for information purposes only. 
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6.3.3. Playing/saving audio comments 
The function is only available if an audio comment is attached to 
the thermal image currently selected (see status bar). It is not 
possible to record, change or delete audio comments. 
> Click on the control key symbols to control the audio functions: 

 (Rewind),  (Play),  (Pause),  (Stop),  (Fast-
forward). 

> Click on  to save the audio file in the file format MP3 or 
Wave.  

6.3.4. Creating image overlay with TwinPix 
An image overlay can be created using the IR image and the 
attached real image2 (taken with the thermal imager) or the 
imported real image (taken with a separate imager) (see Real 
image document window page 36). Both images can be shown 
together in one image. The images are aligned by setting marking 
points.  
The image overlay simplifies the orientation in the image, whereby 
the localization of certain measurement points is made easier, for 
example. 

1.  Click on TwinPix . 
- The Wizard for TwinPix is opened. 
- The First steps tab contains a description of the image overlay 

function. This tab can be hidden:  Do not show this page 
again. 

2.  Click on the Image markings tab. 
3. Set marking points in the IR image and the real image. Note the 

following while doing this: 
• Set the marking points at the same position in both images: 

Use distinctive spots. The zoomed image sections with the 
cursor position displayed below the images help with 
precise positioning. 

• Distribute the marking points throughout the image. Set 
additional marking points in the image area that is of 
particular importance (if possible). 

• The marking points must be set in the same order in both 
images.  

                                                           
2 The real-image lens and IR lens have a different slant due to the special 
separation. This means that the image areas do not correspond exactly 
(parallax error). 
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• At least four marking points must be set.  
• The points are numbered automatically.  

To move a marking point: 
> Move marking point with mouse button pressed. 
To delete a marking point: 
> Select the point in the list below the image and click on 

[Delete].  
- The point is deleted. The corresponding point with the same 

number in the other image is also deleted.  
4. Click on [Continue]. 
- The image overlay is displayed. 
- If the result is unsatisfactory: Return to the Image markings tab 

and optimize the marking points (moving, supplementing with 
additional points)  

The following functions are available to adjust the image overlay: 

Setting transparency level 
The Transparency level regulates the proportion of the infrared or 
the real image in the overlay. The IR readings can even be read off 
with the setting 100 % real image (no IR image visible). 
> Click on the controller. Hold the mouse button down and move 

the controller. 

Setting infrared limit values 
The observation area of the image overlay can be limited with the 
infrared limit values. Only values above an upper limit value or 
values below a lower limit value are shown as infrared image 
information. Only the real image is shown in the irrelevant 
temperature range.  

 

 
With activated infrared limit values, setting the transparency 
level to 100 % infrared is recommended. The relevant 
temperature ranges are thereby most clearly visible.  

 
 

Function Procedure 

Activate Use upper 
limit value or Use 
lower limit value 

> Activate the desired limit value . 

Set Upper/lower 
limit value 
(only available with 
activated limit 
value) 

> Click on the number and change it by 
means of input via the keyboard or via . 

or 
> Click on the controller of the lower/upper 

limit value. Hold the mouse button down 
and move the controller. 
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Setting infrared range 
The observation area of the image overlay can be limited with the 
infrared range. Only values between the two range limits are shown 
as infrared image information. Only the real image is shown in the 
irrelevant temperature range. 

 
With an activated infrared range, setting the transparency 
level to 100 % infrared is recommended. The relevant 
temperature range is thereby most clearly visible.  

 
 

Function Procedure 

Activate Use 
infrared range 

> Activate the alarm range . 

Set Upper/lower 
area limit value 
(only available with 
activated infrared 
range) 

> Click on the number and change it by 
means of input via the keyboard or via .

or 
> Click on the controller of the lower/upper 

range limit value. Hold the mouse button 
down and move the controller. 

 

5. Click on [Finish]. 
- Assistant will be closed. The image overlay is applied in the 

Thermal image document window. All analysis functions can 
be applied on the image overlay, see Evaluating images page 
25. The overlaid image is shown instead of the IR image during 
reporting.  

> To cancel image overlay, see Fehler! Verweisquelle konnte 
nicht gefunden werden., page Fehler! Textmarke nicht 
definiert.. 

6.3.1. Copying settings for several images 
Copies the image settings of the currently selected image to other 
images. Image settings can only be copied to images taken with an 
imager that has the same detector size.  

1.  Click on Copy actual settings . 
- The wizard for copying settings is opened. 
- The Instructions tab contains a description of the function. This 

tab can be hidden:  Do not show this page again. 
2.  Click on the Destination tab. 
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3. Select an option for copying the image settings: 
• Copy settings to all open images.  
• Copy settings to files from disc: if this option is selected, 

the images you want to copy the image settings to must not 
be open. [Add…] opens the Windows dialogue box for 
opening files and the images can be added. 

4. Click on [Next]. 

5. Click on the desired settings to activate them ( ). 
6. Click on [Next]. 
- The image settings are copied over. The result is displayed as a 

table.  
7. Click on [Quitter]. 

6.3.2. Accepting settings for multiple images 
Copies the image settings of the currently selected thermal image 
into all open thermal images. 

1.  Click on Thermal image settings . 
- A dialogue box with the parameters is opened. 
2. Select the parameters that you wish to accept for the other 

infrared images and click on [OK]. 
- The settings are accepted for all open infrared images. 

 

6.3.1. Batch export 
Multiple images can be exported all at once without needing to be 
opened.  

1.  Click on Batch export . 
- The assistant for the batch export opens. 
- The Instructions tab contains a description of the function. This 

tab can be hidden:  Do not show this page again. 
2.  Click on the BMT Files tab. 
3. Choose an option to select the images to be exported: 

• Export the images that are currently open..  
• Export images from the file system:: [Add…] opens the 

Windows dialogue box for opening files and the images can 
be added. 

4. Click on [Next]. 
5. Choose an option to select the target folder: 

• Export to source folder. 
• Export to this folder:: [Browse...] opens the Windows 

dialogue box for searching for folders and the target folder 
can be selected. 
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6. Click on [Next]. 
7. Choose an option to select the file format. 
8. Click on [Next]. 
- The export is carried out. The result is displayed as a table.  
9. Click on [Finish]. 

 

6.4. Evaluating images 
IR images can be edited and evaluated in the individual document 
windows below the work space. 

 

6.4.1. Thermal image document window 
The following functions are available in the Thermal image 
document window: 
• Saving/exporting the infrared image 
• Copying the infrared image to the clipboard 
• Extract single images from a panoramic image 
• Export an image with detector resolution from a 

SuperResolution image (standard imager resolution) 
 • Rotating the infrared image 
• Specifying the readings for one pixel in an infrared image 
• Temperature correction in an infrared image area (adjust 

emissivity and reflected temperature for the area) 
• Specifying a hotspot/coldspot for an infrared image area 
• Creating a histogram of an infrared image area 
• Determine the average temperature of an IR image area 
• Creating a temperature profile for a line 
• Moving/deleting measuring points/range 
• Carrying out data agglomeration 
• Cancelling image overlay 

 

Saving/exporting the infrared image 
 

 
When exporting infrared images in BMP, JPG and PNG 
format only the image data is exported, no readings. 
If you wish to create a temperature table for the infrared 
image, the infrared image must be saved in XLS/XLSX 
format (Excel). 

 

1.  Click on Save thermal image . 
- The Windows dialogue for saving files is opened. 
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2. Enter a file name. 
> If you wish to export the temperature values of the infrared 

image: Select the XLS file format. 
> If you wish to export the image data of the infrared image: 

Select file format BMP, JPG or PNG. 
3. Select a storage location and click on [Save]. 

Copying an infrared image to the clipboard 
When you copy the IR image to the clipboard, an IR image file and 
also the temperature value of each individual pixel of the thermal 
image can be pasted into other programs. 

1.  Click on Copy to clipboard . 
2.  To paste an image file/text file into Excel, Powerpoint or Word: 

1. Open the required program. 
2. In the toolbar of the program, click on the Start tab. 
3. Select the Insert menu. 
4. From the shortcut menu, select the option Insert content.... 

 
 

 
Insert image file/text file into Libre/OpenOffice Calc, 
Impress or Writer: 

1. Open the program. 
2. In the toolbar of the program, click on the Edit tab. 
3. Select the Insert content... menu. 
4. Select Bitmap from the opened menu. 
5. Click on [OK].  

> If you want to insert an IR image file: select the Bitmap 
option and click on [OK]. 

> If you wish to insert the temperature of each individual pixel 
of the IR image: select the Text option and click on [OK]. 

Extract single images from a panoramic image 
Extracts one or several single images from a panoramic image.  
The function is only available if the currently selected image was 
taken as a panoramic image (see imager instruction manual).  

1.  Click on Extract single image out of panorama . 
- The panorama export wizard is opened. 
- The Instructions tab contains a description of the function. This 

tab can be hidden:  Do not show this page again. 
2.  Click on the Images tab. 

3. Select the single images to be extracted ( ). 
4. Click on [Next]. 
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5. Perform the required settings (file format, file name, save 
location). 

6. Click on [Next]. 
- Image extraction is carried out. The result is displayed as a 

table.  
7. Click on [Finish]. 

Exporting an IR image with detector resolution from a 
SuperResolution image 
An image in standard imager resolution (detector resolution) can be 
exported from an IR image taken with SuperResolution. 
The function is only available if the currently selected image was 
taken with SuperResolution (see imager instruction manual).  

1.  Click on Export with detector resolution . 
- Windows dialogue box for saving files is opened. 
2. Enter a file name. The file type (.bmt) must be retained! 
3. Select the location you want to save it to and click on [Save]. 
The function is only available if a TwinPix was created for the 
currently selected image. 

Rotating the infrared image 

> Click on Rotate left  or Rotate right . 

 Specifying the readings for one pixel in an infrared image 
For specifying the temperature, the emissivity and the reflected 
temperature for one pixel in an infrared image. 

 

 
If you wish to specify the temperature within one infrared 
image area (temperature correction), you should first 
highlight the infrared image area and then position the 
measuring points on it. Otherwise, the correctness of the 
temperature displayed for the measuring point cannot be 
guaranteed. 

 

1. Click on Temperature . 
2. Click on one point in the infrared image. 
- Temperature, emissivity and reflected temperature of the 

measured point set here will be displayed in the Thermal 
image markers document window. 

For further information about editing measurement results (e.g. 
changing emissivity), see Thermal image markers document 
window page 34. 
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Correcting temperature in an infrared image area 
For specifying emissivity and a reflected temperature within an 
infrared image area. 

 

 
Infrared images areas with temperature corrections should 
not overlap each other because only one emissivity and 
one reflected temperature is correct per pixel. 
However, if two infrared image areas do overlap, the 
parameters (emissivity and reflected temperature) of the 
most recently entered infrared image area will be used to 
specify the temperature. 

 

1. Click on Temperature correction . 
2. Select a marking form from the drop-down menu (rectangle, 

circle, ellipse, free form shape) 
3. Drag the mouse with the mouse button pressed to highlight an 

infrared image area in the thermal image. 
- The measurement results of the selected infrared image area 

will be displayed in the Thermal image markers document 
window. 

For further information about editing measurement results see 
Thermal image markers document window page 34. 

Specifying a hotspot/coldspot 
For specifying the hottest/coldest point within an infrared image 
area. 

1. Click on Coldspot  / Hotspot . 
2. Select a marking form from the drop-down menu (rectangle, 

circle, ellipse, free form shape) 
3. Drag the mouse with the mouse button pressed to highlight an 

infrared image area in the thermal image. 
- The hotspot/coldspot of the selected infrared image area will be 

displayed in the Thermal image markers document window. 

Determining the average temperature 
To determine the average temperature within an IR image area. 
1. Click on Average 
2. Select a marker from the drop-down menu (rectangle, circle, 

ellipse, freehand tool) 
3. With the mouse button pressed down, drag the mouse to 

highlight an IR image area in the thermal image. 
- The average temperature of the selected IR image area is 

displayed in the Thermal image markers document window. 
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Creating a histogram 
For displaying the frequency of a temperature within an infrared 
image area. 

1. Click on Histogram . 
2. Select a marking form from the drop-down menu (rectangle, 

circle, ellipse, free form shape) 
3. Drag the mouse with the mouse button pressed to highlight an 

infrared image area in the thermal image. 
- The temperature distribution in the selected infrared image area 

will be displayed in the Histogram document window. 
Creating a new histogram deletes the existing one. 
For further information about editing the histogram see Histogram 
document window page 33. 

 Creating a temperature profile 
For displaying a temperature progression over a line. 

1. Click on Temperature profile . 
2. Select the characteristics of the line from the drop-down menu 

(horizontal, vertical, diagonal) 
3. Drag the mouse with the mouse button pressed to draw a line in 

the infrared image. 
- The temperature profile will be displayed in the Profile 

document window. 
Max. 5 profile lines per image can be created. 
For further information about editing the temperature profile see 
Profile document window page 38. 

Moving/deleting image markers in the infrared image 
 

 
If infrared image areas are moved, the set measurement 
markers should be moved along with them.  
If the measurement point remains in the same position or if 
infrared image areas are deleted, the parameters 
(emissivity and reflected temperature) of the measurement 
points must be checked. 

 

>  Click on the measurement markers in the infrared image (not 
possible if the Temperature  tool is activated) or 

> Click on the Marking tool  and drag the mouse with the 
mouse button pressed to create a frame around the 
measurement points/range that you wish to delete/move. 

> If you wish to delete measurement points/ranges: Click on 
Delete . 

- The measurement markers in the infrared image are deleted. 
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- The measurement results will be removed from the Thermal 
image markers, Histogram and Profile document windows. 

> If you wish to move measurement markers: Hold down the 
mouse button and move the measuring points/range. 

- The measurement results will be adjusted according to the 
movement in the Thermal image markers, Histogram and 
Profile document windows. 

Carrying out data agglomeration 
The image can be divided into individual areas. Statistical data can 
be shown for the individual areas.  

> Click on Data agglomeration  and then on the required 
agglomeration level (None, One, Two, Three, Four). 

> Click on Data agglomeration  and then on the required 
information (Min, Max, Avg). 

Cancelling image overlay 

1. Click on Undo TwinPix . 
- A confirmation request will follow. 
2. Click on [Yes]. 

 

6.4.2. Temperature scale document window 
The following functions are available in the Temperature scale 
document window: 
• Setting the scale 
• Setting the limit values 
• Setting the isotherm area 

Setting the scale 
You can choose between automatic scaling (adjustment to the 
min./max. values), manual scaling and ScaleAssist. The scale limits 
can be set within the measuring range that is valid for the image. 
All temperatures that go below or exceed the min./max. value are 
displayed in the colour of the min./max. value (depending on the 
selected colour palette). Temperature ranges that are not relevant 
can thus be hidden. 
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When the Humidity image palette is selected, scale adjustments 
cannot be made. 

 

Function Procedure  

Set Min./max. 
values 

> Click on the number and change it by 
means of input via the keyboard or via .

or 
> Click on the arrowhead of the min./max. 

value on the scale. Hold the mouse button 
down and move the arrow. 

Carry out 
Automatic scaling

> To carry out automatic scaling: Click on  
[  Auto]. 

- The scaling limit values are adjusted to 
the min./max. values. 

ScaleAssist  > To activate ScaleAssist:  
1. Enter the inside and outside temperature 
2. Click on ScaleAssist 
- The scale limits are automatically 

adjusted to the calculated ScaleAssist 
min./max. values. 

 
You will find the ScaleAssist function in the multi-function 
window. 

 

Setting the limit values 
A lower and an upper limit value can be defined. Temperatures 
below the lower limit value or above the upper limit value can be 
marked with one colour. The transparency of the limit value colours 
can be set. 

 

Function Procedure 

Activate Limit 
values 

> Activate the limit values . 

Set Upper/lower 
limit value 
(only available with 
activated limit 
values) 

> Click on the number and change it by 
means of input via the keyboard or via .

or 
> Click on the arrowhead of the lower/upper 

limit value on the scale. Hold the mouse 
button down and move the arrow. 
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Function Procedure 

Select Upper/lower 
limit value colour 
(only available with 
activated limit 
values) 

> Click on Colour upper/lower limit value 
 and select a colour. 

Set Transparency 
(only available with 
activated limit 
values) 

1. Click on Colour upper/lower limit value 
. 

2  Click on the number next to 
Transparency and change it by means of 
input via the keyboard or via . 

 

Setting isotherms (temperature range) 
A lower and an upper area limit value can be defined. 
Temperatures between the lower and upper area limit values are 
marked with one colour. 

 

Function Procedure 

Activate Isotherms > Activate the isotherms . 

Set Upper/lower 
area limit values 
(only available with 
activated isotherms)

> Click on the number and change it by 
means of input via the keyboard or via . 

or 
> Click on the arrowhead of the lower/upper 

area limit value on the scale. Hold the 
mouse button down and move the arrow. 

Select Isotherm 
colour 
(only available with 
activated isotherms)

> Click on Colour isotherms  and select 
a colour. 

If Rainbow is selected, the isotherm is shown 
in a rainbow colour palette. Temperature 
gradings within the isotherm are thus 
rendered visible. 

 
If Rainbow is selected, we 
recommend setting the colour palette 
of the IR image to Greyscale. 
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6.4.3. Histogram document window 
The following functions are available in the Histogram document 
window: 
• Saving a histogram as an image file 
• Copying a histogram to the clipboard 
• Choosing between absolute (number of the measurement 

points) and relative (percent of the measurement points) 
scaling: 

• Setting the background colour for the histogram 
• Switching grid lines in the histogram on/off 
• Setting the number of columns over the temperature range 

being assessed 
 

 
Changes can only be seen if a histogram had already been 
created in the Thermal image document window for the 
infrared image currently open, see Determining the average 
temperature page 28. 

 

Function Procedure 

Saving a histogram as an 
image file 

1. Click on Save file . 
- The Windows dialogue for saving 

files is opened. 
2. Enter a file name. 
3. Select a file format (BMP, JPG, 

PNG). 
4. Select a storage location and click 

on [Save]. 

Copying a histogram to the 
clipboard 

1. Click on Clipboard . 
- Image files from the histogram can 

be inserted in other programs (e.g. 
Microsoft Word). 

Selecting scaling Choosing between absolute (number 
of the measurement points) and 
relative (percent of the measurement 
points) scaling. 

> Click on absolute scaling  or 
relative scaling . 

Selecting background 
colour 

> Click on Background colour  
and select a colour. 

Switching grid lines on/off > Click on Grid lines . 
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Function Procedure 

Specifying number of 
columns 

Set the number of columns over the 
temperature range being assessed 
(settings between 10 and 100 columns 
are possible): 
> Click on the number and change it 

by means of input via the keyboard 
or via . 

 
 

6.4.4. Thermal image markers document window 
Shows the measurement results of the image markers performed in 
the Thermal image document window. The emissivity and the 
reflected temperature of the inserted image marker can be changed 
at the same time here as well. Additional comments can be entered 
for each individual image marker. 
The following functions are available in the Thermal image 
markers document window: 
• Saving/exporting measurement results for the image markers in 

Excel 
• Copying measurement results to the clipboard 
• Deleting measurement results for the image markers 
•  Calculate the temperature difference (DeltaT) between set 

thermal image markers or between an input value and thermal 
image markers. 

• Modifying emissivity and reflected temperature for image 
markers at specific points/ranges 

• Entering comments 
 

Function Procedure 

Saving/exporting 
measurement results in 
Excel 

The measurement results for the 
image markers are saved in an Excel 
table. 

1. Click on Save file . 
- The Windows dialogue for saving 

files is opened. 
2. Enter a file name. 
3. Select the file format XLS. 
4. Select a storage location and click 

on [Save]. 
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Function Procedure 

Copying measurement 
results to the clipboard 

 

 
The data cannot be inserted 
into other programs as an 
image file. 
 

> Click on Clipboard . 
- Measurement results can be 

inserted in other programs (e.g. 
Microsoft Word, Powerpoint). 

Deleting image markers 1. Highlight the line to be deleted. 

2. Click on Delete . 

DeltaT calculation 1. Click on [DeltaT] 
2. Calculate the temperature 

difference: 
select the required thermal image 
markers or enter an input value. 

3. Change the input value: 
click on the number and change it 
by inputting via the keyboard or by 
clicking  with the mouse. 

4. Confirm by clicking [OK] 
- Up to 5 temperature differences 

can be calculated. 
- The results are displayed in a 

separate table in the Thermal 
image markers document window. 
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Function Procedure 

Modifying emissivity and 
reflected temperature for 
image markers at specific 
points/ranges 

 
Changes to the settings 
influence the measurement 
result. The settings should 
only be changed with the 
utmost caution! 

> In the table, click on the value 
(emissivity or reflected 
temperature) and modify it via the 
keyboard or . 

- The temperature of the 
measurement point adjusts to the 
set emissivity/reflected 
temperature. 

- Changes can be seen in the 
Thermal image document 
window. 

Entering comments 
 

> Click in the comment field and use 
the keyboard to enter the text. 

 
 

6.4.5. Real image document window 
The following functions are available in the Real image document 
window: 
• Importing real images 
• Exporting real images 
• Copying a real image to the clipboard 
• Inserting a real image from the clipboard 
• Deleting a real image 
• Rotating a real image 
• Modifying the brightness of a real image 
• Change image section 
• Insert additional image 

 

Function Procedure 

Importing real images 1. Click on Open . 
- The folder containing the real 

images opens. 
2. Highlight a real image and click on 

[Open]. 
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- The real image selected will be 
displayed in the Real image 
document window. 

Exporting real images 1. Click on Save file . 
- The Windows dialogue for saving 

files is opened. 
2. Enter a file name. 
3. Select a file format (BMP, JPG, 

PNG). 
4. Select a storage location and click 

on [Save]. 

Copying a real image to 
the clipboard 

> Click on Clipboard . 
- The real image can be inserted in 

other programs (e.g. Microsoft 
Word, Powerpoint). 

Inserting a real image from 
the clipboard 

> Click on Clipboard Insert . 
- The confirmation request is 

opened. 
> If you wish to insert the real image 

from the clipboard: Click on [Yes]. 
- The real image is inserted from the 

clipboard. 
> If you wish to cancel the process: 

Click on [No]. 

Deleting a real image 1. Click on Delete . 
- The confirmation request is 

opened. 
2. Click on [OK]. 
- The real image is deleted. 

Rotating a real image > Click on Rotate left  or Rotate 
right . 

Modifying the brightness of 
a real image 

1. Click on Brightness . 
- The dialogue box is opened. 
2. Use the scroll bar to modify the 

brightness of the real image. 
3. Click on [OK]. 

Insert additional image 
 

1. Click on [Additional Image] 
2. Use Open file to add an additional 

image file to the thermal image. 
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Zoom in/zoom out/move 
real image/fit to document 
window 

> Click on Zoom in  (or move the 
mouse wheel forwards) to zoom in 
on the real image. 

> Click on Zoom out  (or move 
the mouse wheel back) to zoom 
out of the real image. 

> Click on Fit  to fit the real image 
to the document window. 

If the set image size is bigger than the 
document window: 
> Click with the mouse button on the 

real image and move the image 
while holding the button down to 
change the visible image section.  

 
The currently visible real image 
section is displayed in a report. 
Check how the real image 
looks before creating a report. 

 
 

6.4.6. Profile document window 
Displays the temperature profiles created in the Thermal image 
document window. 
The following functions are available in the Profile document 
window: 
• Saving a temperature profile as an image file 
• Copying a temperature profile to the clipboard 
• Selecting the presentation of the temperature profile 
• Changing the background colour of the temperature profile 
• Switching grid lines on/off 

 

Function Procedure 

Saving a temperature 
profile as an image file 

1. Click on Save file . 
- The Windows dialogue for saving 

files is opened. 
2. Enter a file name. 
3. Select a file format (BMP, JPG, 

PNG). 
4. Select a storage location and click 

on [Save]. 
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Function Procedure 

Copying a temperature 
profile to the clipboard 

> Click on Clipboard . 
- Image file from the profile can be 

inserted in other programs (e.g. 
Microsoft Word). 

Selecting the presentation 
of the temperature profile 

> To select filled out profile: Click on 
. 

Several profile lines are displayed 
in individual card tabs (P1, P2, …).

> To select a line profile: Click on .
Several profile lines are displayed 
in individual card tabs (P1, P2, …).

> To select a general line profile for 

all profile lines: Click on . 

Changing the background 
colour of the temperature 
profile 

> Click on Background colour  
and select a colour. 

Switching grid lines on/off > Click on Grid lines . 
 
 

6.4.7. Comments document window 
> Use the keyboard to enter the comments about the currently 

selected infrared image in the text field. 
 

6.5. Creating a report 
You can create a report with one or more infrared image(s). A 
Report Wizard will guide you through the process. Several report 
templates are available for creating simple reports: 
• Thermal bridges in building shells in accordance with EN 13187 

(comprehensive) 
• Thermal bridges in building shells in accordance with EN 13187 

(simplified test) 
• Industry (Archiv) 
• Industrial thermography 
• MaxiPicture 
• MultiPicture 
• Short report 
• Standard report cover picture 
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• Standard report (humidity) 
• Standard report (solar) 
• Standard report 
1.  In the ribbon, click on the Report tab. 

2. Click on Report Wizard . 
- The Report Wizard is opened. 

Report tab 
Depending on the report template selected, the Report Wizard is 
divided into the following tabs: 
• Template 
• Image selection 
• Company address / Logo 
• Address / Location 
• Job description 
• Freetext 
• Ambient conditions 
• Conclusion 
• Preview 
> Work through the individual tabs from left to right and note the 

respective tips  at the bottom of the window. 
- The data entered appear automatically in the report. 

Saving a report 
1. Click on the Preview tab. 
- A preview of the report is opened. 

2. Click on Save report . 
- The Windows dialogue for saving files is opened. 
3. Enter the file name and select a file format. 
4. Select a storage location and click on [Save]. 
- The report will be saved in TIR file format. This will create a file 

with the images and the report data entered. 
 

 
Reports that are created with IRSoft as of version 2.4 
cannot be opened with older software versions. 

 

Saving the report as a PDF or RTF 
1. Click on the Preview tab. 
- A preview of the report is opened. 

2. Click on PDF  or RTF . 
- The Windows dialogue for saving files is opened. 
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3. Enter a file name, select a storage location and click on [Save]. 
- The report is saved as a PDF or RTF. 
Reports saved in RTF format are compatible with Office 2003 and 
higher. 

Printing report 
1. Click on the report tab Preview. 
- A preview of the report is opened. 

2.  Click on Print . 
- The Windows dialogue for printing a report is opened. 
3. Complete the print settings if necessary and click on [Print]. 
- The report is printed. 

 

6.6. Modifying the report 
Data in a saved report can be modified. 

1. In the Report tab, click on Restore saved report . 
- The Windows dialogue is opened. 
2. Navigate to the directory where the report is stored. 
3. Select a report and click on [Open]. 
- The Report Wizard is opened. 
- Report texts can be modified in the Report Wizard. 
> To edit images afterward: 

1. Click on the Report Wizard. 
- The report data are displayed in the work space in individual 

document windows. 
- Report texts remain in the Report Wizard. 
2. Carry out the desired image edits. 
3. In the Report tab, click on Report Wizard. 
- The edited image is inserted in the Report Wizard. 
- The existing texts are displayed. 

4. Save the report with the changes. 
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6.7. Report Designer 
With the Report Designer you can create your own report template 
by changing an existing template to meet your needs. There are 
tools available to help you design and edit the report template to 
your liking. 

 

 
The Report Designer is used exclusively for creating 
individualised report templates. The reports themselves are 
created by selecting the report template in the Report 
Wizard. 

 

Opening the Report Designer 
Requirement: at least one infrared image must be open. 

1. Select the Settings tab and click on Report Designer . 
- The dialogue box is opened. 
2. Select the report template that you would like to edit and click 

on [OK]. 
- The Report Designer is opened. 

 

6.7.1. User interface 

Ribbon 

 
The ribbon helps you to carry out modifications and settings in the 
Report Designer and to find the relevant functions and commands 
quickly.  
The functions and commands are divided into different groups on 
two tabs: Report Designer and Preview. 
The functions/commands and the work space vary depending on 
the tab selected. 
The tab Report Designer contains function/commands for: 
• Saving the report template 
• Editing the report template 
• Changing the report template view 
The tab Preview contains function/commands for: 
• Printing a report 
• Editing and aligning the page layout 
• Changing the report template view 
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Work space 

 
Modifications are carried out in the work space in the Report 
Designer tab. It consists of the file directory tree and the open 
report template. The file directory tree contains prescribed fields 
that you can pull into the report template. 
When the Preview tab is selected, the work space view changes. 

 

6.7.2. Functions and commands 
All of the functions/commands in the ribbon are described in more 
detail in tips (tool hints). 
> Move the mouse pointer over the functions/command in the 

ribbon. 
- Tips (tool hints) are displayed. 

 

6.7.3. Editing a report template 

Overview 
The open report template consists of various areas. Fields can be 
inserted into or removed from each area. 
• Report Header: contains fields with general information that 

appear once in the report template (e.g. company, instrument, 
client, etc.). When the report is created later, this information 
appears at the beginning of the report. 

• Page Header: contains fields with information that appears on 
each page in the header. 
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• Bottom Margin: contains fields with information that appears on 
each page in the footer. 

• Detail: contains fields with information about the corresponding 
measurements (e.g. location, ambient conditions, etc.) 

• Detail Report "Picture": contains placeholders for image and 
text fields with information about the infrared images (emissivity 
and reflected temperature, comments about the individual 
infrared images, histogram, temperature profile, etc.). The 
Detail Report "Picture" area is repeated in the report depending 
on the number of infrared images. 

• Report Footer: contains fields with information that appears at 
the end of the report template (e.g. general comments, 
conclusion, date and signature, etc.) 

 
 

 

Text changes:  

Only carry out text changes in fields without the symbol . 
 
 

Dragging prescribed fields into the report template 
You can integrate data, images, tables and tools from the file 
directory tree into the report template to modify it to meet your 
needs. 

 

 
Note the report template areas into which you drag the 
fields. For example, image fields should only be integrated 
into the Detail Report "Picture" area. Because the image 
fields serve as placeholders, each may only be dragged 
once into the Detail Report "Picture" area. 

 

1. Click on the Report Designer tab. 
2. In the file directory tree, click on the desired option. 
3. Hold down the mouse buttons and drag the field into the 

desired position in the report template. 
- The field is aligned to the grid. 

 

 

With free text fields, additional, freely selectable 
information can be included in reports. 
If a free text field is included in the report template, the 
Freetext tab is also shown in the report wizard.  
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Modifying fields 
Font, font size and text alignment can be changed for the fields. 
1. Click on the Report Designer tab. 
2. In the report template, click on the field that you wish to adjust. 
3.  To highlight several fields: 

> Hold down the Ctrl-key and click on the fields or 
> Drag the mouse to create a marker frame around the fields. 

4. Use the editing functions in the ribbon to modify the fields. 
- The changes will be applied to all highlighted fields. 

Aligning fields 
Requirement: at least two fields must be highlighted. 
1. Click on the Report Designer tab. 
2.  To highlight several fields: 

> Hold down the Ctrl-key and click on the fields or 
> Drag the mouse to create a marker frame around the fields. 

3. Use the editing functions in the ribbon to align the fields. 
- The changes will be applied to all highlighted fields. 

Moving field(s) 
1. Click on the Report Designer tab. 
2. In the report template, click on the field(s) that you wish to 

move. 
3. Hold down the mouse button and drag the field(s) to the desired 

position. 
- The field(s) align to the grid. 

 Modifying field size(s) 
1. Click on the Report Designer tab. 
2. In the report template, click on the field(s) where you wish to 

adjust the size. 
3. Click on one of the black contact points of the field(s) and 

change the size of the field(s) by dragging with the mouse 
button pressed. 
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Deleting field(s) 
1. Click on the Report Designer tab. 
2. In the report template, click on the field(s) that you wish to 

delete. 
3. To delete fields: 

> On the keyboard, press the [Del] key or 
> Right-click with the mouse and select Delete. 

Deleting a field has no effect on the size and position of other 
fields. Empty spaces between fields can be prevented by moving 
fields or changing their size. 

Entering text in a text field 
1. Click on the Report Designer tab. 
2. Double-click on a text field in the report template and enter the 

text via the keyboard. 
- Text appears as a fixed block if the report template is selected 

in the Report Wizard. 

Saving a report template 
1. Click on the Report Designer tab. 

2. Click on Save . 
- The Windows dialogue for saving files is opened. 
3. Enter a file name and click on [Save]. 
- The report templates are saved in a folder based on the 

operating system and operating system language. 
> To find the report templates: Select the search function in 

Explorer and search for the *.repx file. 
- Report templates (file format .repx) will be displayed. 

Deleting a report template 
 

 
• Note that report templates are deleted permanently. 

After they are deleted, report templates cannot be 
restored. 

• Only "User" type report templates can be deleted. 
 

Requirement: the Report Designer must be closed. 
1. In IRSoft, in the ribbon, click on the Settings tab. 
2. In the ribbon, click on the Report Designer. 
- The dialogue box is opened. 
3. Select the report template that you wish to delete. 
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4. Click on [Delete]. 
- The confirmation request is opened. 
>  If you wish to permanently delete the report template: Click on 

[Yes]. 
> If you wish to cancel the process: Click on [No]. 

Editing the page layout 
1. Click on the Preview tab. 
2. Use the editing functions in the ribbon to adjust the page layout. 

 

6.7.4. Tips & tricks 

Creating a report template with a cover image 
1. Move the PageHeader header bar far enough down to leave 

sufficient space for the cover image. 
2. In the ReportHeader report section, select all fields from 

Company to Job and move these to the bottom of the report 
section. 

3. From the PageHeader report section, copy the fields Title, 
Logo and the line directly below both fields into the 
ReportHeader report section above the Company field. 

4. Above the fields inserted in the last step Insert a Page break 
(Tools folder). 

5. Above the page break inserted in the last step insert the Cover 
image field (Images folder) and adjust the size of the field as 
needed. 

Creating a report with an additional real image 
> In the DetailReport - "Picture" report section, insert the Real 

image 2 field (Images folder) and adjust the size of the field as 
needed. 

 
 

 
Use the Real image 2 field exclusively within the 
DetailReport - "Picture" report section to ensure that it is 
assigned to the thermal image added to the report. 

 
 

Creating a report with a digital signature 
> In the ReportFooter report section, insert the Digital signature 

field (Images folder) directly above the signature line and adjust 
the size of the field as needed. 
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Creating a report with two thermal images side by side 
1. In the DetailReport - "Picture" report section, delete the Real 

image field. 
2. In the DetailReport - "Picture" report section, click on the 

Detail1 header bar. 
- A white box with an arrow is displayed next to Detail1. 
3. Click on the box. 
- The DetailBand advanced settings dialogue window is 

opened. 
4. Make the following settings: 

• Column direction: AcrossThenDown 
• Number of columns: 2 

5. Click on the box to close the dialogue window. 
- In the DetailReport - "Picture" report section, a grey section is 

displayed with the information: Space for repeated columns. 
Controls placed here will not print correctly. 

6. Customise all fields in the DetailReport - "Picture" report 
section, ensuring that no fields protrude into this grey section.  

Creating a report with fixed textual content 
1. Go to the report section that you wish to insert text into. 
2.  Insert the Text field field (Tools folder) at the required position 

and adjust the size of the field as needed. 
3. Input the text into the field. 

Inserting a watermark  
1. In the multi-function bar click on the Preview tab. 
2. Click on Watermark. 
- The Watermark dialogue window opens. In the left half of the 

window you will see a preview of the subsequent settings. 
3. In the text and / or picture tab make the required settings with 

regard to the content, layout and size of the watermark. 
4. Under Position, select whether it should be printed behind or in 

front of the report content. 
5. Under Page Range, select the pages on which the watermark 

is to be inserted. 
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6.8. Configuring the instrument 
The configuration makes it possible to perform settings on the 
thermal imager using IRSoft. 
In both tabs Picture settings and Instrument settings, all settings 
can be performed that can also be performed using the instrument 
menu of the thermal imager. For this, please also observe the 
instruction manual for the thermal imager. 

 

A user-defined material list from specified materials (including the 
associated emissivity) can also be copied over to the imager. 
Additional functions can be activated in the imager by entering an 
activation code, e.g. SuperResolution (not for testo 880) and full 
radiometric video measurement (only for testo 885-2 and 
testo 890-2). 
Requirement: 
• Thermal imager is connected to the PC 
• Thermal imager is switched on and recognised by the PC 
1. In the ribbon, click on the Imager tab. 

2. Click on Configuration . 
- The Characteristics of Testo Thermal Imager dialogue 

window is opened. 
3. Choose between image and instrument settings. 
4. Complete the settings (see Picture settings page 49 and 

Instrument settings page 50). 
>  If you wish to transfer the settings to the thermal imager: Click 

on [Apply]. 
> If you wish to discard the settings: Click on [Cancel]. 
5. Click on [OK]. 
- The dialogue window is closed. 

Picture settings 
Function availability depends on the model of the connected 
imager. 

 

Function  Settings 

Selecting the 
temperature scale

Choose between automatic scaling, 
ScaleAssist and manual scaling: 
> Select the desired option. 
> With the selection of manual: Enter the 

min. and max. value. 
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Function  Settings 

Setting the palette, 
temperature unit, 
LCD brightness, 
measuring range 

Select required settings: 

> Click on  and select the desired value 
from the drop-down list. 

Transferring 
materials 

Transfer the desired materials with the 
corresponding emissivity to the thermal 
imager or IRSoft: 

 
The language of the materials to be 
chosen from depends on the 
language of the operating system. 
The language of the materials present 
in the thermal imager depends on the 
setting of the instrument language 
during commissioning. It is therefore 
possible that materials are displayed 
in different languages. 

1. Click on the materials in the Materials in 
thermal imager list that are not required 
and remove these by clicking on . 

2. Click on the required materials in the For 
selection of stationary materials list and 
copy these by clicking on  in the 
thermal imager. 

A maximum of 8 materials can be saved in 
the thermal imager. 

Emissivity 
settings 

Activate desired material: 

> Click on  and select the desired material 
from the drop-down list. 

> With the selection of User-defined: Enter 
the value of the emissivity. 

 

Instrument settings 
Function availability depends on the model of the connected 
imager. 

Function  Settings 

Setting Language Activate the desired language: 

> Click on  and select the desired 
language from the drop-down list. 
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Function  Settings 

Switching the 
Power save 
function on/off 

Select the desired setting (Switch off imager 
or Switch off LCD): 

> Click on  and select the desired function 
from the drop-down list. 

Automatically hide
(function keys, 
cursor, scale) 

Activate the desired function: 
> Click on the desired functions to activate 

them ( ). 

Carrying out 
factory reset 

Carry out a factory reset: 
1. Click on [Factory reset]. 
- A confirmation request will follow. 
2. Click on [Yes]. 

Synchronizing 
with PC clock 

Synchronize the date and time of the 
instrument with the PC: 
> Click on [Synchronize with PC clock]. 

Firmware 
Update… 

The imager software (firmware) can be 
updated. Current firmware data can be 
downloaded from www.testo.com/irsoft 
1. Click on Firmware Update…. 
- The Windows dialogue box for opening 

files appears. 
2. Select the update file and click on [Open].

Activation code 
entry 

Activate additional functions in the imager: 
> Enter the activation code and click on 
[Confirm]. 
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6.9. Video (only for testo 885 / 890) 
With the video function, the thermal image from the imager can be 
displayed live on the PC and recorded. 
With the testo 885-2 and testo 890-2, it is possible to carry out full 
radiometric video measurement and capture a logger sequence 
(optional instrument function). 
> Select the Video tab. 

Work space 

 
1 Video stream 
2 Image marks 
3 Profile 
The size of an area can be adjusted by clicking and dragging the 
area border. 

Display information on the video file 
> Click on Info to open the dialogue window.  

6.9.1. Establishing/disconnecting a connection 
The connection to the imager can be established and disconnected 
again.  
> Click on Connect to establish a connection to the imager 
- The image is displayed in the software. 
> Click on Disconnect to disconnect the connection. 
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6.9.1. Settings 
Camera settings can be carried out using the software. 

Initiating auto-focus 
This function is only available if auto-focus was enabled in the 
camera before a connection was established. 
> Click on Autofocus. 

Initiating the shutter manually 
> Click on Shutter. 

Enabling/disabling the automatic shutter function 
In the case of stable environmental conditions and set-ups that do 
not heat up the sensor/camera, the automatic shutter function can 
be disabled to avoid interruptions in the video. Deviations in 
accuracy and image quality are negligible in a period of up to 
60 minutes. 

 
 

 

The disabled status remains even after the camera has 
been disconnected from the PC. Re-enabling can be 
carried out by re-starting the camera. 

 
 

> Click on Automatic Shutter. 
If Automatic Shutter has an orange background, the function has 
been enabled.  

Changing the colour palette 
 
 

 

The palette setting remains in the camera even after the 
camera has been disconnected from the PC.  

 
 

>  Click on  and select the required palette from the drop-down 
list. 

6.9.2. Capturing a video/logger sequence 

Start “Wizard for capture settings” and select “Capturing 
mode” 

1. Click on Capture Settings . 
- The Wizard for capture settings is opened. 
- The First steps tab includes a description of the capture 

functions. This tab can be hidden:  Do not show this page 
again. 

2. Click on the Capturing mode tab. 
3. Select the required capturing mode: 
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• Capturing of a video: capturing a video sequence. 
• Capturing a logger sequence (only testo 885-2 and testo 

890-2 with option of full radiometric video measurement): 
capturing a sequence of individual images with a defined 
start, duration and interval. 

Capturing of a video: settings 
The folder, file name, file format and maximum size or length of the 
video can be set. 
4. Click on the Settings tab. 
5. File: click on [Browse…] and enter the parameters/settings: 

 

The videos can be saved in various formats: 
• MPEG file (only for cameras with 33 Hz)/WMV file 

(compressed or uncompressed): 
video file in which pure image data is saved but no 
measuring values (temperature or humidity values). 
Existing image marks (measuring points and profile 
lines) are also saved as image data and cannot be 
subsequently changed or deleted. 
If an image mark has been set, when video 
capturing is carried out, the capturing of the 
measuring value diagram is started automatically, 
but there is no automatic saving. Saving measuring 
value diagrams as an image or exporting them as 
an Excel file must be done after video capturing 
manually via the relevant buttons, separately for 
each measuring value diagram. 

• VMT files (full radiometric video, only testo 885-2 
and testo 890-2 with option of full radiometric video 
measurement): Video file in which image data, 
measuring values and image marks are saved. 
Saved files can be played back in testo IRSoft and 
subsequently analysed by adding or changing 
image marks. 
The number of individual files captured (frames) per 
second corresponds to the video frequency of the 
camera, provided the system environment supports 
this frequency (see system requirements), but max. 
25 Hz. 

 

> Select folder and enter file name. 
> Select the file format and click on [Save]. 

6. Stop capturing after…: select MB (limit according to file size in 
megabytes, max. 10000 MB) or sec (limit according to duration 
in seconds, max. 86400 s, corresponds to 24 h) and enter the 
required size or duration for the video. 
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Capturing of a logging sequence: settings 
Start criterion, capturing interval and file name/file format can be set. 
4. Start tab: select a start criterion and enter the parameters: 

• Immediately: capturing starts when you click on Start 
Capture. 

• Limit value over/undershooting: capturing starts during the 
first over or undershooting of the set temperature after 
clicking on Start Capture. 

• Timed: capturing starts after expiry of the entered duration 
(max. 24 h 00 min, min. 0 h 1 min) after clicking on Start 
Capture. 

5. Interval tab: enter the number of images to be saved and the 
capturing interval (min. 3 s). 

6. File tab: select a file format and enter the parameters/settings: 

 

The logger sequences can be saved in various formats:
• BMT files: 

sequence of individual image files (thermal images). 
Image marks (measuring points and profile lines) 
are also saved as image data and cannot be 
subsequently changed or deleted. 
If an image mark has been set, when sequence 
capturing is carried out, the capturing of the 
measuring value diagram is started automatically, 
but there is no automatic saving. Saving measuring 
value diagrams as an image or exporting them as 
an Excel file must be done after image sequence 
capturing manually via the relevant buttons, 
separately for each measuring value diagram. 
The individual thermal images of the sequence can 
be displayed under the Analyze tab and analysed. 

• VMT files (full radiometric video, only testo 885-2 
and testo 890-2 with option of full radiometric video 
measurement): Video file in which image data, 
measuring values and image marks are saved. 
Saved files can be played back in testo IRSoft and 
subsequently analysed by adding or changing 
image marks. 
The playback speed (frames per second) 
corresponds to the video frequency of the camera, if 
the system environment supports this frequency 
(see system requirements), but max. 25 Hz. 

 

> VMT: click on [Browse…], select folder and file name and 
click on [Save]. 
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> BMT: click on [Browse…], select the folder and click on 
[OK]. Enter prefix for the file name. 

Saving capture settings 
7. Click on the Summary tab. 
8. Check the settings and click on [Finish]. 

Starting/ending capture 
 

 

The video is saved under the file name and location 
selected in the capture settings.  

 

- The capture settings have been carried out. 
> Click on Start Capture. 
- Capture is started. 

 
 

- The diagrams of the set measuring points/profile lines are 
captured after the start of the capture with the video. This 
enables diagram data that corresponds time-wise to the 
captured video to be saved. 

> End capture manually: click on Stop Capture. 
- If capture is not ended manually, it ends automatically 

according to the set capture criteria. 

6.9.3. Playing/analysing/saving videos 
Saved VMT files can be played in testo IRSoft and analysed using 
the image marks. It is not possible to play saved MPEG/WMV- files 
in testo IRSoft. For this, use separate software (e.g. Windows 
Mediaplayer (recommended) or VLC Player). 

Opening a video file  

1. Click on Open . 
2. Select a video file and click on [Open]. 

Playing a video file 
 
 

 

In logger sequence capturing mode, video playback is not 
carried out in real time but in time lapse (with the image 
refresh rate of the camera). The time stamp of the 
individual images (frames) corresponds to actual time 
during capture. 

 
 

> Start playback: Play. 
> Pause playback: Pause. 
> Go back to the start: To beginning. 
> Display a specific frame (individual image): enter number under 

Frame and click on Go to or select frame with . 
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Analysing and re-saving saved videos 
The analysis functions (see below) can also be applied to saved 
VMT files. The files can then be saved with the new/changed 
analysis data.  
1. Click on Save as. 
- Windows dialogue box for saving files is opened. 
2. Enter a file name, select a file format and click on [Save]. 
3. Click on [OK]. 

Switching back to capturing mode 
> Click on Connect to re-establish a connection to the camera  

 Determining measurement values at an IR image point 
To determine the temperature at an IR image point. 

1. Click on . 
- A measuring point is inserted into the image. 
- The current temperature and coordinates of the image point are 

displayed on the right next to the image. 
- The measurement value characteristic curve of the image point 

is displayed in a measurement value chart below the image. 

 Creating a temperature profile 
To display a temperature curve via a line. 

1. Click on . 
- A profile line is inserted into the image. 
- The min./max./average temperature and coordinates of the 

profile line end points are displayed on the right next to the 
image. 

- The current temperature curve of the measuring points on the 
profile line is displayed in a measurement value chart below the 
image. 

Deleting/moving image marks on the IR image 
> Click on the measurement mark on the IR image. 
- The mark is highlighted red. 

> If you want to delete the measuring point: click on Delete . 
> If you want to move the measuring point: hold down the mouse 

button and move the measuring point. 
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Producing a snapshot 
One frame of the video stream can be captured and exported as a 
thermal image including image marks. No real image is attached to 
the thermal image. 

1. Click on . 
- Windows dialogue box for saving files is opened. 
2. Enter a file name. 
3. Select a folder and click on [Save]. 

Coldspot / Hotspot anzeigen 

1. Klicken Sie auf  bzw. . 
- Coldspot bzw. Hotspot werden angezeigt. 

Saving a measurement value chart as an image 
Measurement value charts can be saved as an image. 

 

 
Only image data is saved - no measurement values. 

 

1. Select the relevant tab of the measuring point or the profile line 
and click on . 

- Windows dialogue box for saving files appears. 
2. Enter a file name. 
3. Select the location you want to save it to and click on [Save]. 

Exporting measuring values from a measuring value diagram 
as an Excel file 
1. Select the relevant tab of the measuring point or the profile line 

and click on . 
- Windows dialogue box for saving files appears. 
2. Enter a file name. 
3. Select the location you want to save it to and click on [Save]. 

Re-starting diagram capturing 

> Click on  to re-start the capturing of the measuring value 
diagram. 

Show grid lines in the measuring value diagram 

> Click on  to show the grid lines. 
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6.10. Archive (only for testo 885 / 890) 
The archive function manages images captured with an imager that 
supports site recognition. 
In the archive, measurement sites can be created and are then 
automatically assigned an identification number (ID). This ID can 
be transferred to the imager, and ID markers can be printed out 
and affixed to the measurement site. When carrying out a 
measurement on site, by setting a marker with the built-in digital 
imager, the images, which are then saved, are automatically 
allocated to the relevant measurement object (allocation is saved in 
this image). When transferring images to the PC, please use the 
import assistant and select the “Add to archive” option. The images 
are then saved automatically in the archive under the correct 
measurement object. 

Work space 

 
1 Archive tree 
2 Information area 
The size of an area can be adjusted by clicking and dragging the 
area border. 

Opening an image from the archive 
> In the archive tree, double-click on the image you want to open. 

Adding a project/folder/measurement object 
To structure the archive data, projects can be created in the archive 
for which details in the form of address data can be saved. For 
further grouping, folders can be created within the projects (up to 3 
folder levels are possible). Measurement objects can be created 
directly in a project or in folders. 
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Function Procedure 

Add project (only 
available at archive 
level) 

> Click on Archive. 
1. Click on Add project. 
2. Enter a project name and the address 

data for the project. 

Add folder (only 
available at the 
project and folder 
levels) 

> Click on the project/folder in which you 
want to create a folder. 

1. Click on Add folder. 
2. Enter a folder name. 

Add measurement 
site (only available 
at project and folder 
levels) 

> Click on the project/folder in which you 
want to create a measurement object. 

1. Click on Add measurement site. 
2. Enter a measurement object name. 
- The measurement object is automatically 

assigned a unique ID. 

Editing the archive 
The archive structure can be changed. 

Function Procedure 

Cut and Paste 1. Click on an element you want to reassign. 
2. Click on Cut. 
3. Click on the measurement 

object/folder/project to which the element 
is to be assigned. 

4. Click on Paste. 

Remove an 
element 

1. Click on the project/folder/measurement 
object you want to delete. 

2. Click on Remove. 

Up or Down 
(moving an 
element) 

1. Click on the project/folder/measurement 
object you want to move. 

2. Click on Up or Down. 

Further functions 

Function Procedure 

Send to camera 1. Click on Send to camera to transfer the 
archive structure to the imager. 

- The archive structure is created in the 
imager. 
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Function Procedure 

Print new 
markers… (only 
available if there 
are still 
measurement 
objects without a 
printed marker) 

1. Click on Print new markers…. 
- Dialogue box for printing markers 

appears. 
2. Select the paper format used. 
3. Click on the label at the position where 

the printing of the markers should be 
started. 

- The selected label is marked “1”. 
Additional markers that are printed are 
marked “2”, “3”, ….  

4. Click on [OK]. 
- A PDF file is created and can then be 

printed. 

Search… 1. Click on Search…. 
- Dialogue box for searching for elements 

appears. 
2. Select the element type you want to 

search for. 
> If necessary, enter the search filter criteria 

to limit the number of hits. 
3. Click on Start search. 

Start import 
assistant… 

1. Click on Start import assistant…. 
- Dialogue box for searching for folders 

appears. 
2. Select the folder from which you want to 

import data and click on [OK]. 
- The import assistant is opened. 
3. For information on what to do next, see 

Using the Import Wizard, page 9. 

Open images of 
the last import 

> Click on Open images of the last 
import. 

- All images of the last import process are 
opened. 
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Editing a measurement object 
An image can be assigned manually to a measurement object. An 
ID marker for a measurement object can be printed. This function is 
suitable for reprinting markers for individual measurement sites. 

Function Procedure 

Assign image… 1. Click on the measurement object to which 
an image should be assigned. 

2. Click on Assign image…. 
- Windows dialogue box for opening files 

appears. 
3. Select the image to which you want to 

assign the measurement object and click 
on [Open]. 

Print marker… 1. Click on the measurement object for 
which you want to print an ID marker. 

2. Click on Print marker…. 
- Dialogue box for printing markers 

appears. 
3. Select the paper format used. 
4. Click on the label at the position where 

the marker should be printed. 
- The selected label is marked “1”. 
5. Click on [OK]. 
- A PDF file is created and can then be 

printed. 
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7 Tips and assistance 
 

7.1. Questions and answers 
 

Question/problem Possible causes/solution 

How can the software be 
uninstalled? 

> To uninstall the software, insert the 
program CD and follow the 
instructions of the Uninstall 
Wizard.  
If the process does not begin 
automatically, start the Setup.exe 
file.  

How can I get information 
about software updates? 

> Make sure that in the Settings tab 
in the Program updates group, 
the Automatic check function is 
activated. 

If this function is activated, you will 
regularly receive information as soon 
as a new update is available. 

How can a software update 
be performed? 

When performing a software update, 
the existing version does not have to 
be uninstalled. 
1. Download the software update 

from the Internet to your PC. 
2. Perform the installation of the new 

version, see Installing the 
software/driver page 8. 

How can an archive be 
copied to another PC? 

Please get in touch with your contact 
at the Service department for detailed 
instructions. 

Then imager cannot be 
configured. 

> Check if the instrument is 
recognised by the PC. 

> Check the connection between the 
instrument and the PC. 

The Import Wizard does 
not start up. 

> Start up IRSoft before connecting 
the thermal imager. 

> Check whether the Import Wizard 
is active: Imager tab | Import 
Wizard. 
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Question/problem Possible causes/solution 

--- or +++ is shown instead 
of the reading. 

The reading was outside of the 
measurement range when the infrared 
image was recorded. No reading is 
available for the selected 
measurement point. 

xxx is shown instead of the 
reading. 

Reading cannot be calculated. 
> Check parameter settings for 

plausibility. 

The entire surface of a 
humidity image is shown in 
one colour. 

The parameters Temperature and 
Humidity were not entered correctly 
in the camera. The humidity image 
cannot be shown correctly without 
these values.  
> Correct parameter settings. 

 

If we could not answer your question, please contact your dealer or 
Testo Customer Service. For contact details see the rear side of 
this document or the web page www.testo.com/service-contact. 
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8 Index

A 
Activating/deactivating the Import 
Wizard 10 
Aligning fields 45 

C 
Cancelling image overlay 30 
Capturing a logger sequence 53 
Capturing a video 53 
Carrying out data agglomeration 30 
Comparing IR images - Tab groups 
14 
Copying an infrared image to the 
clipboard 26 
Correcting temperature in an 
infrared image area 28 
Creating a histogram 29 
Creating a temperature profile 29, 
57 
Creating image overlay with 
TwinPix 21 

D 
Deleting a real image 37 
Deleting a report template 46 
Deleting field(s) 46 
Deleting/moving image marks on 
the IR image 57, 58 
Determining measurement values 
at an IR image point 57 
Dragging fields into the report 
template 44 

E 
Entering comments 36 
Entering text in the text field 46 
Establishing a connection with the 
instrument 9 
Excel 26, 34, 35 
Exporting real images 37 

I 
Image stitching 26 
Importing real images 36 
Instrument settings 49, 50 

M 
Modifying emissivity and reflected 
temperature for image markers at 
specific points/ranges 36 
Modifying field size(s) 45 
Modifying fields 45 
Modifying the brightness of a real 
image 37 
Moving field(s) 45 
Moving/deleting image markers in 
the infrared image 29 
Multifunktionsleiste 11 

O 
Opening infrared images 17 
Opening the Report Designer 42 

P 
Picture settings 49 
Playing/analysing/saving videos 56 
Powerpoint 26, 37 
Printing report 41 
Program interface language 16 

R 
Real image in Explorer preview 16 
Report tab 40 
Report template - Editing the page 
layout 47 
Rotating a real image 37 
Rotating the infrared image 27 

S 
Saving a histogram as an image 
file 33 
Saving a report 40 
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Saving a report template 46 
Saving a temperature profile as an 
image file 38 
Saving the report as a PDF or RTF 
40 
Saving/exporting measurement 
results in Excel 34 
Saving/exporting the infrared image 
25 
Selecting scaling 33 
Selecting the presentation of the 
temperature profile 39 
Setting isotherms (temperature 
range) 32 
Setting the limits 31 
Setting the scale 30 
Specifying a coldspot/hotspot 28 

Specifying a hotspot/coldspot 28 
Specifying number of columns 34 
Specifying the readings for one 
pixel in an infrared image 27 
SuperResolution image 27 

T 
Temperature unit 15 
Tips (tool hints) 15 
TwinPix 21 

U 
Using the Import Wizard 9, 61 

W 
Word 26, 33, 35, 37, 39 
Work space 12 
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